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Designing Online Education

The design of engaging online education is not about the technology; it is about student engagement. Simply put, student engagement is about 
creating an emotional attachment between the student and the material, the student and the instructor, and the student and other students. In 
other words, engaging online education creates strong networks of interpersonal relationships (Lowe as cited in Levine, 2005) that provides 
dense nodes and networks of communication that permits learners to engage in knowledge creation that leads to deep learning. 

As the course leader, you establish the emotional hooks that cause students to engage in the curriculum. While online courses are designed 
in advance, it is the instructor’s application of learned activities that guides, clarifies, facilitates and encourages deep learning with students 
during course delivery. The Online Course Delivery in Three Acts is a powerful model that bridges and supersedes the work of Stephen D. 
Lowe (2005) and Gilly Salmon (2001). It links course design with course delivery in a meaningful way, which allows instructors to present 
academic and relational/social support at the right place, the right time, and the right amount. The power of the model is in its diagnostic 
capabilities. When the online course does not unfold as expected or is interrupted by dynamic events (punctuated equilibrium), referring to 
the model assists the instructor in adjusting the amount of academic and relational support that is needed to return to a stable state.   

No longer is it necessary for instructors to cobble together a patchwork quilt of best methods from the literature of online and face-to-face 
courses, in order to determine the best practices for online course design. Built on sound theoretical principles, the three-act model lets 
course instructors, trainers and designers, from novice to expert, expand upon their current knowledge and utilize personal experience to 
overcome the E Storm created when pedagogy, technology, and learner needs collide in the online classroom. Rounding out the model is 
an arsenal of instructional tips and strategies that complements course design and builds flexible learning environments to support social 
learning and minimize student multitasking away from the course site. Learn the model; apply its techniques to make your classes a 
memorable learning experience. 
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Act I:  Syllabus Blues (Guide)
During the first third of the course, creating emotional attachments is difficult because the students are 
occupied with trying to navigate the site and determine what is required to pass the course. 

From the instructor’s point of view it makes no sense to try building relationships when the student’s focus 
is on understanding the curriculum and the evaluation requirements.

From the students’ point of view they are dependent learners. They want to be told what to do, when to do it, 
and where to look to be told what to do.

Relationship Support is low. This is the time to build trust with the students by responding to their requests 
with guidance and direction. That builds self-esteem that the student can indeed be a successful online 
learner. 

Academic Support is high. During this act the instructor is building the student’s self-confidence and 
establishing a trusting relationship with the students. 

Instructor Focus should be on assisting, facilitating, and guiding students around the course learning 
management system, responding to technical questions with just-in-time assistance, and preparing the student 
for the first plot point, that being the first graded assignment. 

Instructor Tip: You can use short video conferences, less than five minutes, to provide just-in-time 
assistance. 

Plot Point One: The administration of the first graded assignment marks the end of Act I Syllabus Blues and 
the transition to Act II: Curriculum Delivery.

Learner: Dependent
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Act II:  Curriculum Delivery (Clarify and Encourage)
By the second third of the course students should understand the course requirements and be able to navigate 
the course management system. They should be engaging in the curriculum on a superficial level developing 
responses to discussion questions singularly and with no intention of integrating ideas in their classmate’s 
postings. 

Relationship Support is increasing. The instructor is building — bridging social capital, establishing and 
reinforcing nodes of communication between himself or herself and the students. The focus is understating 
the curriculum as theory. The turning point occurs (second plot point) when the instructor challenges the 
students to move beyond the theoretical to synthesis and application of the theoretical knowledge. 

Academic Support is lower. The instructors focus has shifted from didactic instructor to subject matter expert. 
The nodes of communication among students have taken root and the instructor is moving from responding 
to technical questions to using his or her expert knowledge to assist the student in analyzing and synthesizing 
the information. 

From the instructors’ point of view they begin to do what they were hired to do — deliver the curriculum. The 
instructor strengthens the communication networks by challenging the students to take different perspectives 
on the course curriculum. 

From the students’ point of view they are independent learners. They can navigate the system, are comfortable 
posting their thoughts, and they comprehend the theory. But, as the momentum builds, the instructor moves 
from clarifying theoretical points to encouraging the students to move beyond comprehension to analyzing 
and synthesizing the course material. 

Instructor Tip: Be patient and monitor the course. If the discussion appears to be lagging give the students 
time to respond. They may be dealing with other issues (punctuated equilibrium). 

Plot Point Two: The excitement created when students interact among themselves and build knowledge.  Act 
III: Three C’s (Challenge, Critical Thinking, and Creation of Knowledge).

Learner: Independent
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Act III: Three C’s (Challenge, Critical Thinking. 
Creation of Knowledge)

By the last third of the course students are fully engaged with the course 
material, contributing to the discussion forum, and building scaffolds 
of new knowledge. Friendships and communication networks and 
nodes have been established physically and emotionally. The thought 
of breaking these ties saddens the students. The instructor prepares 
the students for the completion of the course, congratulates them and 
celebrates their success in becoming interdependent self-actualized 
online learners. 

Relationship Support is self-maintaining, self-fulfilling, and perpetual. 
The instructor’s role is diminished to maintaining communication 
network and notes.  

Academic Support is at its lowest point. The course’s management 
system has become the student’s home. He or she knows how to 
function within its structure and how to get help. The class has become 
a functioning, self-directed team that is comfortable responding to each 
other’s questions without the need of an intermediary, the teacher. 

From the instructor’s point of view the learning objectives of the course 
have been achieved. Students have engaged in knowledge creation and 
deep learning.  

From the students’ point of view they are interdependent learners. 
They have experienced the deep learning that comes with knowledge 
creation.

Instructor Tip: Provide praise and celebrate the class’s accomplishments. 
Congratulate them on their persistence and the success achieved. 

Plot Point Three: The Resolution. The course is over and the students 
are confident they can transfer the learning from this course to the next 
course 

Learner: Interdependent

Academic Support

Relational Support
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Glossary

Academic Support
Institutional technology support as represented by a stable learning management system, a competent and readily accessible technology help desk, 
and the emotional support from the academic administration reinforces the idea that online education is as rigorous as face-to-face learning.

Bridging Social Capital
Bridging social capital encompasses creating relationships with people that are from diverse backgrounds with more distant ties among students of 
different backgrounds 

Plot Point
It is a significant event within a plot that digs into the action and spins it around in another direction.

Punctuated Equilibrium
Theory that proposes that organizations move through periods of stability followed by short periods of dynamic, fundamental change that ends with a 
return to stability.

Relational Support 
Affective dimension of the learning process as expressed in the attitudinal quality of the interpersonal relationships between facilitator and learner. 
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IDEAS FOR EFFECTIVE ONLINE INSTRUCTION

Tips from the Pros

Creating a Network of
Learners

By Rob Kelly

When referring to a group of
online learners, Caterina

Valentino prefers the term
“network of learners” to
“community of learners.”
Network of learners is a more
apt description because “it’s a
much more dynamic visualiza-
tion than ‘community of
learners,’” says Valentino, an
innovator in the delivery of
distant education, adjunct
professor at the School of Health
Services Management at
Ryerson University and a
Sessional Instructor at
Athabasca University’s Centre
for Nursing and Health Studies.
Her vision of a network of
learners is an interdependent
group in which learners learn
from each other and create new
knowledge. This does not
happen by chance, Valentino
says. It’s a deliberate process
that involves a two-pronged
approach based on the Providing
Academic and Relational
Support (PARS) model created
by Stephen Lowe.  

Academic support includes
things such as helping student
manage all the “mechanics” of
online learning—the technology
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5 Ways to Challenge Your Students in
Online Discussions
By Nicole Hickland-Harris, MISM

Discussion is an essential
learning activity whether you

are teaching in a traditional
classroom with an online component
or teaching a fully online course.
There are many ways to engage
students on topics that will help
them participate actively in class
discussion. Over the years, the idea
of discussing a topic in class has
evolved from having a face-to-face
discussion in between lecture topics
to allowing the students to speak
about lecture content in a full online
discussion forum. Engaging
students can make a major differ-
ence in online discussions, which
generate exchanges that allow
students to appreciate the topic
discussed and to lead a new level of
topic understanding.

Below are five tips that can help
to add value to your classroom’s
online discussion. 

1. Post early, post often, and post
content to help the student.
Each class week is a new

beginning for the student. It is
important for instructors to engage
students and keep them interested
in the course and the content. One
way to do this is to start the discus-

sion forum by capturing your
students’ attention. This can be
done by posting early, posting often,
and posting content that will engage
them. One way to accomplish this is
to create a system of posting a new
question each morning. When
material is posted early, students
can recognize a new week and start
it the right way. If you post a new
week’s material at 7 a.m., for
example, it will give students a
chance to have full access to the
material as early as possible.
Posting often is also essential, espe-
cially when it comes to discussion
questions. It is important to contin-
ually engage the students and
provide them with challenging topics
that will propel the discussion
forward.

2. Bring examples and your own
experience to the classroom.
One of the most effective ways to

reach students is to give them a
window into your experience. This
applies to the traditional classroom
and the online classroom. Students
in the online environment have the
challenge of not being face to face,
yet they are still trying to gain the
same information as if they were.
One way to make them feel engaged

Continued on page 8 >>
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E N G A G E M E N T

By B. Jean Mandernach, PhD

Student course engagement
“typically refers to the amount,

type, and intensity of investment
students make in their educational
experiences” (Jennings & Angelo,
2006, p. 6). While research over-
whelmingly supports the value of
engagement for promoting student
achievement and retention, the
research is less definitive in its
guidance concerning how to monitor
whether or not your students are
engaged. The challenge in assessing
engagement is that it is not openly
visible and rests primarily within
internal student characteristics.
Engagement encompasses a range of
academic correlates, including per-
sonality, affective, motivational, and
persistence factors; it is driven by
“students’ willingness, need, desire
and compulsion to participate in, and
be successful in, the learning process”
(Bomia, Beluzo, Demeester, Elander,
Johnson & Sheldon, 1997, p. 294). 

Recognizing the value of engage-
ment and its vital role in the educa-
tional process, faculty should
monitor student engagement as a
formative strategy to examine the
impact of their teaching and assess-
ment activities. A number of formal,
self-report assessments of student
engagement are available; for
example:
• Student Engagement Index

(Langley, 2006)—Developed to
identify specific measures of
classroom engagement aligned
with the benchmarks set forth by
the National Survey of Student
Engagement (NSSE).

• Revised Student Experiences
Questionnaire (CSEQ) (Koljatic &
Kuh, 2001)—Assessment aligns
general issues of engagement
according to student-faculty

contact, cooperation among
students, and active learning.

• Revised Student Engagement
Questionnaire (Handelsman,
Briggs, Sullivan & Towler, 2005)—
Measures four dimensions of
course engagement: skills,
emotional, participation/interac-
tion, and performance engage-
ment. 

• Student Engagement Survey (SE)
(Ahlfeldt, Mehta & Sellnow,
2005)—Short assessment that
adapts specific items from the
NSSE survey for use at the course
level.

• Faculty Survey of Student
Engagement (FSSE) (Ouimet &
Smallwood, 2005)—An adaptation
of the NSSE designed to assess
faculty perceptions of student
engagement in a specific course.

• Classroom Survey of Student
Engagement (CLASSE) (Smallwood
& Ouimet, 2009)—The comple-
mentary measure to the FSSE
designed to assess student per-
ceptions of engagement in a
course.

While these formal measures may
provide a useful metric for
summative examinations of student
engagement, faculty wishing to
adapt their instructional strategies
to maximize engagement may wish
to monitor informal, formative indi-
cators of student engagement
throughout their courses. As such,
the issue becomes how to monitor
student engagement in your online
course when you cannot see the
looks of excitement, interest, or
enthusiasm. 

Engagement can be monitored via
three primary avenues: participation
in asynchronous discussions,

Indicators of Engagement in the 
Online Classroom

Continued on page 3 >>
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assignment activity, and course
involvement. The key to monitoring
engagement is to examine students’
self-initiated course activity that
extends beyond the graded expecta-
tions of the course. For example: 
1) Asynchronous discussions:

a. Student asks relevant questions
that contributed to a more
meaningful discussion.

b. Student integrates diverse per-
spectives in response to discus-
sion items.

c. Student initiates assistance or
support to facilitate classmates’
mastery of course material.

d. Student applies theories and/or
concepts to practical problems or
new situations. 

e. Student actively participates in
discussions beyond the
minimum expectations for par-
ticipation.

2) Assignment activity:
a. Student prepares multiple drafts

of an assignment prior to sub-
mission.

b. Student voluntarily engages
classmates for collaboration
outside the scheduled course
activities.

c. Student synthesizes and/or
organizes ideas, information, or
experiences into new, more com-
plicated interpretations and rela-
tionships.

d. Student evaluates the value of
information, arguments, or
methods to assess the accuracy
of his/her conclusions.

e. Student utilizes feedback from
assignments to improve his/her
understanding and future per-
formance.

3) Course involvement:
a. Student contacts you with

course-related questions that
extended the meaning of the
required course material.

b. Student works effectively to
identify, understand, and

complete all given course assign-
ments and tasks.

c. Student logs in to class on a
regular basis and participates
beyond the minimum require-
ments of the course.

d. Student seeks out additional
information or readings to com-
plement course topics.

e. Student completes all readings
and studies on a regular basis.

f. Student seeks out additional
feedback or comments on
his/her work.

In addition to these behavioral
observations, faculty should monitor
students’ self-reports of engagement
that may appear in course activity
journals, discussion groups, or other
informal interactions. 

As highlighted by Nauffal (2010),
“The concept of student engagement
is receiving increased attention
globally as it is viewed as an
important element in assessing and
improving the quality of higher
education” (slide 8). This issue is
compounded in the online classroom
where faculty may be under
increased scrutiny to demonstrate
the overall quality of the educational
experience. Faculty are encouraged
to actively monitor student engage-
ment to guide instructional and
assessment choices as well as to
expand definitions of course effec-
tiveness beyond simple emphasis on
cognitive learning.
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By Patti Shank, PhD, CPT

In this series of articles, I’ve been discussing ways to
improve using PowerPoint as an online teaching and

learning tool. This month, I’m concluding this series
with some tips and tricks for working with PowerPoint
clip art. 

Clip art use is a bit of a can of worms. When done
poorly, adding clip art can make your slides look less
professional. But when done well, clip art can improve
slide aesthetics. So you should do it well! PowerPoint is
a visual communication tool. Slides with a wall of words
or with long bullet lists up the snooze factor of your
online presentation. So, when designing your slides, you
must consider how to show what you are talking about
rather than merely telling what you are talking about in
slide text. You can expound on what you are showing
using narration, which is generally more interesting
than telling in text. And if there’s a lot to tell, consider
adding downloadable documents to read.

The instructions I’ll be providing in this month’s
article are for PowerPoint 2007, but the instructions are
very similar for other versions. 

Want more?

Let’s say you find the
clip art provided with
PowerPoint to be pretty
limiting and wish you
had more. Easy—get
more!

When using clip art in
PowerPoint, you have a
choice of using clip art
from a variety of collec-
tions (see Figure 1,
shown when you click
Insert> Clip Art).

Figure 1. Clip Art Pane

You can create your own collections by letting
PowerPoint scan your hard disk for other illustrations
and photographs. The Clip Organizer will place images
that are found into the My Collections folders. You can
also download free clip art from the Microsoft Office
Online Clip Art and Media site (http://office.microsoft.
com/en-us/images/), and these clips are stored in a

Downloaded Clips folder in the My Collections folders. 
Office Collections includes all the clips that come

with Microsoft Office, so these clips are the ones you
expect to see when you look for clip art to use. Web
Collections includes clips from the Microsoft Office
Online collection (you must be connected to the Internet
to use these). If you include this collection in your
search, you will find and be able to use the clips
available on the Microsoft site too.

So, to have access to more clips, check all three col-
lections and search for what you need! If you need addi-
tional clips, you can buy more on sites such as
iCLIPART (www.iclipart.com/microsoft).

Keep a PowerPoint graphics library

Last month I talked about manipulating clip art so
you get images that are closer to what you really want.
That can take some time and effort. Then, when you
want to use that image again, you need to remember
what slide deck the image is in so you can copy it and
paste it into the new slide deck. Far too much work!
(Not to mention the time it takes to search and the
chance that you won’t remember what slide deck the
image is in.)

In order to make reuse of images easier, consider
creating a PowerPoint library to make it easy to find the
clip art you might want to use again. (This idea came
from another instructional designer/developer, Jenise
Cook of Ridgeview Media.) 

Start by opening a blank PowerPoint file and save it
with a name such as PowerPointGraphicsLibrary.pptx
(or .ppt if you are using earlier versions of PowerPoint).
After finding or manipulating clip art elements that you
might want to reuse, copy them onto slides in the
Library slide deck. Consider organizing the slides by
types of graphics, such as faces clips, household object
clips, background clips, etc. Use slide titles to label the
types of clips on each slide. 

When you want to find and reuse these clips, open
the PowerPoint graphics library file and change the view
to Slide Sorter View (Figure 2). This view lets you see
all your slides at once and
makes it easier to find the
image you are looking for. Once
you find the slide that has the
image you want to reuse,
double-click on it and the
program will open that slide in
Normal View. Then you can

4 Online Cl@ssroom
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Figure 2. Change to
Slide Sorter View
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copy the desired image and paste it
into your new slide deck.

Copy formatting from one clip art
element to another

If you manipulate clip art, such
as adding a drop shadow (Drawing
Tools>Format>Shape Effects>
Shadow), you may want to add the
same effect to other clip art
elements in the slide deck. To save
time applying the same effect to
other clip art elements you want to
manipulate in the same way, you
can easily copy formatting from one
clip art object to another. 

Here’s how. Once
you have one clip
art element
formatted the way
you want it, select it
and then click the
Format Painter
button (Figure 3).
Then click the other
clip art element (the
one you want to
reformat). The second
clip art element is now formatted
with the attributes of the first clip
art element. Such a time-saver!

Next month, I’ll start a related
series of articles on adding
narration and interactivity to your
online PowerPoint presentations.

Patti Shank, PhD, CPT, is a widely
recognized information and instruc-
tional designer and writer and
author, who helps others build
valuable information and instruction.
She can be reached through her
website: www.learningpeaks.com.
@
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Figure 3

and the policy and procedures of
the course. Relational support
refers to creating and supporting
productive interaction among
students and between students
and the instructor. Relational
support builds upon academic
support. In the first third of the
course academic support is the
predominant type of support
that instructors need to
provide—“getting students over
the hump or what I call the
‘syllabus blues,’” Valentino says.
“Whether you’re a novice or an
expert, there’s always trepidation
regarding the syllabus. The
students want to know what it
takes to get an A.”

In addition, there is what
Valentino refers to as the “tech-
nology blues,” helping students
understand the learning man-
agement system. “So that’s the
first part. Even before you can
start building relationships with
the students and getting them
into the academics of the course,
you have to go through the
‘syllabus blues’ and the ‘technol-
ogy blues’. Then when that
begins to subside you can start
working on the relational
support,” Valentino says.

At the core of relational
support is the idea that learning
is a social event, Valentino says.
The online classroom is a social
atmosphere where students
connect with each other and
where they have the opportunity
to put their ideas out there for
others to agree or disagree with,
analyze, and critique. 

As the facilitator, Valentino

models how she expects
students to interact by the way
facilitates the course. Here are
two simple suggestions that help
students form a network of
learners:

• Address students by name.
• Link posts together. Make it a

point to link similar or
opposing points together and
respond by name to the
authors of those posts. (“Dear
John, Mary, and the rest of
the class…”)
“Once you get them over the

hump and they’re comfortable in
the environment, then you can
start asking questions and facili-
tating, which is not only linking
students’ postings but challeng-
ing them with new theories,”
Valentino says. “When you start
out, the instructor is probably
being pedagogical. As the course
progresses, the relationship
becomes more androgogical [the
role of the instructor is
minimized]. And when the
network is popping, you’re facili-
tating. You’re being a conduit of
communication. You’re linking
them together. You’re importing
your expert knowledge into their
knowledge creation to help them
understand the curriculum
better.”  

On December 7 Caterina
Valentino will lead the Magna
Online Seminar “Strategies to
Engage Online Learners &
Promote Deep Learning.” For
information, see
http://www.magnapubs.com/
catalog/engage-online-learners/.
@
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By Errol Craig Sull

In writing this column for more
than four years, I have received

many emails asking for information
on a variety of topics, and no
question is asked more frequently
than how to keep online students
engaged. This issue is at the heart
of any distance learning course.
When students are engaged, the
class is exciting, learning is more
likely to occur, the students want to
be a part of the course on an
ongoing basis, and the students
give you and the school outstanding
evaluations. Much has been written
on this subject, and should I
choose—and if my editor allowed
it—this column could be hundreds
of pages long. But it is a column,
not a book, so I offer six surefire
ways to get and keep students
engaged in an online course and, as
a bonus, two activities that always
result in enthusiastic student
engagement throughout the course.

Strategies

Post a “Welcome to the
Course!” announcement that is
enthusiastic and motivating.
Your first post is probably the most
important of your course, as the
students get an immediate sense of
you—your enthusiasm, approach
(inviting or intimidating?), attitude
(upbeat or not really interested?),
and willingness to help out. And
unlike a face-to-face course where
these words are spoken then
quickly forgotten, here they are
available for your students
throughout the course, 24/7. (And
remember: read over any post,
email, webmail, announcement,
etc., before sending it to the class:
its overall content, writing quality,
and proofreading must be your
best ... each time!)

Be first whenever possible. You
set the tone for the students. When
they see you as an enthusiastic
member of the class, it helps to get
them revved up: they know they
will not be on their own, feel you
truly enjoy teaching the class, and
know you have a real interest in
their learning. And when they
know this, your students will
become more engaged. So be sure
you always have the first post of

each new discussion topic. Post an
overview to the coming week
(module, unit, etc.), and give little
reminder announcements through-
out the course so students can see
that you are an engaged instructor
at all times. 

Respond to all student
queries, etc., within 24 hours.
The all-important “umbilical cord”
that connects you to the students—
the computer—must constantly be
fed by you; when you allow it no
food of your thoughts, reactions,
instructions, etc., students will be
less likely to stay involved in the
course. Perhaps the most crucial
component is quickly responding to
any student posts that shout,
“Help!” or “I’m confused!” or—in
essence—“I just wanted to share
this with you, professor!” In these
instances, the students are
reaching out to you, and your
quick response tells them that you

are interested in what they have to
say, you are active in the course,
and you can be depended upon—
three qualities that go a long way
toward keeping students engaged. 

Be certain all assignment
feedback is detailed and positive
in tone. Students are obviously in
class to learn, and the more
material they receive relating to the
class subject, the better. To help
this along and to keep students
engaged, offer on all assignments
detailed feedback that leaves the
students with a positive feeling, no
matter how poorly they may have
done. To accomplish this: [a] Be
sure your comments on assign-
ments point out that something is
not correct, why it is not correct,
and how to get it right. [b] Give
your students a breakdown of how
you arrived at their grades (and if it
is an ungraded assignment give
them a faux grade so they can get a
sense of the quality work they are
submitting). [c] Always point out a
few things the student got right;
this is especially important for
students who did poorly on an
assignment. [d] Make your last
sentence or two positive one—it
helps motivate a student to do
better. (Suggestion: set up rubrics
for each assignment, even if your
school does not require them. They
offer thorough feedback on all
areas of an assignment and allow
for great motivating text from you.
If you would like to see some, let
me know—I’ll happily send you
some of mine!)

Respond to all—or nearly all—
student discussion postings. For
most courses where discussion
postings are required, this can
become the heart of the course—it
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Be sure your comments
on assignments point
out that something 

is not correct, 
why it is not correct,
and how to get it right.
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is here where students explore
segments of the course subject,
interact with one another 24/7,
and can touch on areas of the
course not included in your
syllabus. While most students will
eagerly respond to one another,
your constant presence reminds
students of your sincere interest in
the course, allows you the opportu-
nity to continually push discus-
sions forward, and can keep the
course discussions on track. To
accomplish this: [a] Respond to all
or nearly all student discussion
postings—this really keeps
students enthused about being
involved in discussion. [b] At the
end of each day, post a major
comment on the discussion topic,
ending with a question for the
students to explore for the next 24
hours. This keeps your discussions
always fresh, something the
students will appreciate. [c] On the
last day a discussion thread is
“alive,” end with a posting that
sums up the discussion topic—and
be sure to include an upbeat note
at the end. 

Have ready a frequently asked
questions link at the beginning
of your course. No matter how
much information is included in
your course, students will continu-
ally ask questions that range from
course logistics (“How do I post an
attachment?”) to content (“When
did the periodic table of elements
add Au for gold?”). The latter will
usually require individual
responses, as it is more likely that
one or two students will ask such a
question. But for the former—and
many basic ones like it—you are
wise to post a frequently asked
questions link somewhere in your
course prior to day one. Not only

will this save you time—instead of
writing individually, many students
will simply use the information
posted—but students will also
appreciate the care you take in
trying to help them. (Suggestion:
take all new questions, concerns,
etc., students raise and add them
to a file you keep. This way you will
have items you can add for each
new course you teach.)

Activities

Establish and populate an
“extra resources” section in your
course. There is much happening
in the everyday world of life—
outside your course—that relates to
your subject; the more students
see those connections, the more
important your course becomes
beyond a grade. So constantly be
on the prowl for such items—
YouTube clips, articles and essays,
pictures, etc.—that highlight and
reinforce all or certain segments of
your course. These add to the value
of the course and show you to be
an instructor who really wants to
immerse the students in a full
learning experience—traits
students will certainly appreciate.
(Suggestion: also use crossword
puzzles and other games and
cartoons for excitement. See
www.puzzle-maker.com/CW/.)

Have students search for
useful and fun websites for the
class. This is always a great
activity and really helps keep
students engaged. Whether you do
this in a discussion thread or
elsewhere, have each student find
three websites useful to the subject
or your course and three websites
that are fun or unusual. Be sure
each student adds one line of
explanation under each website.
The students—and you—benefit
from the helpful sites, and all in

the class have some lighter
moments through the non-course-
related sites. This is a great way to
have students feel they are a true
part of the course, offer additional
course assistance, and have some
plain old fun—and keep students
enthusiastically engaged.

Please let me hear from you,
including sending along suggestions
and information for future columns.
You can always reach me at errol-
craigsull@aol.com. And remember:
please forward me your computer
tips and suggestions to make
teaching in the online classroom
more efficient and productive. 

Errol Craig Sull has been teaching
online courses for more than 15
years and has a national reputation
in the subject, both writing and con-
ducting workshops on it. He is
currently putting the finishing
touches on his next book—How to
Become the Perfect Online
Instructor. @

<< From Page 6

REMEMBER: Great
Thanksgiving get-togethers:
excellent combinations of
quality and quantity of food,
joyous interactions of the
folks present, and overall
smooth and hassle-free cele-
brations—we don’t want them
to end! Yes, these engaging
experiences take effort to
pull off ... as do online
classes. 
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is to provide specific, detailed expe-
riences that they can relate to. This
can be achieved by drawing on your
background and experience that
qualified you to be hired as an
instructor in the first place. You can
then take this experience and create
working case studies for your
students; students will truly gain
from it an understanding of how the
industry works. 

Here is an example:
Prior to becoming an online

instructor, I worked for 10 years in
the field of information technology.
During this time, I gained an in-
depth understanding of the software
development life cycle, which is
standard for most organizations
that plan huge (tier 1 and 2) infor-
mation technology projects. When I
began teaching, I saw this as an
opportunity to walk my students
through a “day in the life” of how
the software development life cycle
works. Since I knew this process
inside and out, it was very easy for
me to compile my thoughts and the
industry standards, and then
present them to my students to
generate discussion … and boy, did
they! 

3. Customize your discussion
forum as much as possible. It
creates an environment that
makes the student feel com-
fortable.
This tip will propel your class

discussion to the next level. Think
about it: the online discussion
forum leaves so much to the imagi-
nation. Customization allows you,
as the instructor, to make your dis-
cussion area “feel” as comfortable
as possible. Here are a few ideas for
you to customize your classroom.

• Post a note welcoming students

to the forum.
• Post information about the

textbook and lecture notes.
• Provide a chat room where

students can post biographies
and get to know each other. 

• Post your biography.
• Create a “student lounge” where

students can chat about things
that may not necessarily fall
under the objectives for the week. 

• Post reminder notes for deliver-
ables for the week.

• Post supportive readings that
may aid the students in under-
standing weekly course concepts.

• Post a weekly “Questions for the
Professor” thread so that
students can have contact with
you.

• Post wrap-up information at the
end of a week, summarizing the
weekly class objectives.

• Post your individual thoughts on
the weekly concepts, and allow
students to have a “day in the
life” glimpse of how the concepts
affect the career.

• Provide extensive and detailed
examples when available.

4. Provide timely and detailed
grade book feedback.
You may be wondering how this

point will help students discuss
topics more thoroughly. Well, the
truth is, feedback is essential for
students to understand what they
are doing right versus what they are
doing wrong. It is important for
students to understand as early as
possible through grading what the
instructor expects in discussion
forums. A good recommendation for
instructors during the first week is
to provide feedback on the first dis-
cussion as soon as possible. As the
instructor, you should give students
very detailed feedback and remind
them to contact you should they
have any questions. Students will
appreciate receiving forum feedback

early during the first week because
it helps them understand your
expectations. In return, you will
find that when your students
understand your expectations, they
engage in better discussion!

5. Answer questions as soon as
possible and post responses so
that the entire class can
benefit from them.
This tip may sound a bit repeti-

tive, but I have included it to
reinforce the notion of interacting
with students as often as possible.
It is in the best interest of the
instructor to provide accurate and
timely responses to questions
presented by the students. Students
typically may post questions in the
discussion forum, asking about a
topic addressed in class. It is
helpful to respond as soon as
possible because it gives clarifica-
tion, which usually generates more
discussion! 

Nicole Hickland-Harris is a professor
at Axia College and Baker College,
teaching several courses in Web
design, computer science and
technical writing. Nicole also runs
her blog (www.educatedandfabu-
lous. com) full time. @
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Online Seminar Call for
Proposals

Magna Publications is
accepting proposals for its online
seminar series. Like the newslet-
ter, these seminars share
practical advice on online course
design, teaching, and course
management. For more informa-
tion on how our online seminars
work, visit www.magnapubs.com
calendar/index-cat-type.html. To
submit a proposal, visit
www.magnapubs.com/mos
proposal.html.


